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General Information

The information contained in this guide is intended to provide an overview of the GASWorkS™ software
by demonstrating a portion of its extensive feature set. Although the GASWorkS feature set is not fully
demonstrated, we hope that the features used during the exercises will provide a good appreciation for how
GASWorkS may be able to satisfy your network modeling needs.

The demonstration software is a full-featured, time-limited version of GASWorkS. Working the example in
this guide should give you a good introduction to the software’s features and ease of use. The example in this
guide is for a simple distribution-style piping system; however please remember that the tasks used to create,
solve, and edit this model are applicable to any type of gas piping system. The example exercise is a bit long;
however, please be patient and persistent in working through it - completion of the example will provide a
valuable lesson on how to use the software to efficiently meet your modeling needs. If you wish to explore
the software further, we suggest reviewing the examples contained in the Help Guide.

System/Hardware Requirements

GASWorkS will operate on any device configured to run Windows 8 through Windows 11. Best performance
will be achieved when using a device with an elevated memory size and higher processor speed. The use of
a mouse or similar pointing device is recommended. The use of a touchpad or similar device is discouraged.

The GASWorkS software will require a minimum of 18 MB of free hard disk space when installed. An
internet connection is required for the license management system, help documentation, and the use of the
GeoMap functions.

GASWorkS uses the Microsoft .NET Framework for some functionality. An appropriate version (4.8 or

newer) of the Framework must be installed on the machine for GASWorkS to function properly. Not all
versions of Windows support the required version of the Framework.

Installing GASWorkS

An appropriate version of Windows must be running in order to install GASWorkS. If it is not, start
Windows now, then proceed with the installation process described below.

Note... . .. . .
You will need to be logged on as the Full Administrator or use the “Run as administrator” option

when executing the installation file.

® Using the provided link, download the setup file (.exe) to your device. Using Windows File Explorer,
navigate to the file’s location.
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® Double-click the setup file name. If a Windows Security warning appears, allow your device to execute
the file.

® After the setup program has been started, several screens will be displayed during the installation process.
Read each screen carefully and respond appropriately.

Note... On the Terms Of Use screen, read the TERMS OF USE AGREEMENT carefully and select the

“I agree to...” option. If you do not wish to accept the Terms Of Use, you will not be able to
continue with the installation process.

® A message will be displayed when the installation process is complete. The message will indicate whether
the installation was successful or failed. Select the appropriate option to clear the message.

Starting GASWorkS

Note...| An appropriate version of Windows must be running before GASWorkS may be executed. If

Windows is not running, start it now.

* The device must be connected to the internet the first time that the GASWorkS software is
executed.

* You will need to be logged on as the Full Administrator or use the “Run as administrator”
option the first time you execute the GASWorkS software.

® From the Windows Desktop, double-click the GASWorkS 11 Demo shortcut icon.

® The GASWorksS software will be started, and
the Welcome screen will be displayed. Click
the Continue command button.

GASWorks StartUp.. X

WelcomeTo GASWorksS...

Licensed To: B3PE Training
Expires In: 35 Days
User Limit: 10 Current Users: 1

® The Demonstration Notes screen will be
displayed. Read carefully, then click the
Continue command button. The Graphic Data
Interface (GDI) Window will be displayed.

Click Continue To Start Application...

Join Qur User List

B3PELLC

Cancel...

Continue...

Copyright ® 2021-2025

B3PE LLC | All Rights Reserved.
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Using The Help System

The help documents are stored on the B3PE server. You must be connected to the internet to access the
various GASWorkS help and support documents.

The GASWorkS Help Guide can be used to view examples and how-to tips on performing a specific task.
The GASWorkS User’s Manual provides information on specific screens and commands, as well as detailed
instructions, descriptions, and explanations.

Once a document is opened, it can be saved locally if you wish. If you save a help document to your machine
for offline access, you must open it directly in your Portable Document Format (PDF) document viewer. A
suitable PDF document viewer or reader is required to view and print the documents.

Note... GASWorksS first looks for help files in the “docs” folder of the “app” folder of the GASWorkS

root directory. If the requested file exists, it will be opened from that location, eliminating the
need to download it from our server. It is suggested that you save downloaded help files to that
location (usually “c:\Program files (x86)\GASWorkS 11\app\docs”) for faster display.

The Help Menu

Access to the various help documents and information is provided in the Help menu. You can also view our
contact information, send a help request, or visit our website. Note - Some features require an internet
connection to work properly.

Contact Us

Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However, if you have a problem, please try at any time - we may be in.

By Telephone - (719) 578-9391

By Email - help@b3pe.com

By Website - www.b3pellc.com
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Example

Various example files are included when GASWorkS is installed on the hard disk. These files are installed
in the “files” subdirectory of the GASWorkS root directory. The example files contain a variety of system
types. You can view, manipulate, and solve these example files - or use the instructions in the following
sections to create, edit, solve, and report your example model.

In this example, a model will be developed for a simple piping system representing a light industrial park
using generic loads. Once the model is built and solved, a new connection and demand will be added to the
system. The new load will exceed the system’s capacity. Changes will be made to the system to allow the
addition of the load. During the example, you will learn how to create a new model using various coordinate
entry methods, solve a model, display graphic results, color code based on result values, edit pipe and node
data, tap an existing pipe, and use the report features.

The resulting model should look similar to the image in Figure 2 (page 14).

Note... . . .
* GASWorkS has an automatic save feature which can be turned “on” or “off” depending on the

User’s preference. As initially installed, the option is turned “on.” To change this preference
option, select the Options & Settings item from the Utilities menu. Select the Environment data
tab from the User Options & Settings screen.

* This example assumes that the settings, options, and default data values are set to the originally
installed values. If they have been changed, some of the example steps may not behave or appear
as described.

If GASWorksS is not running, start it now. If a model is already open, close it now by selecting the Close item
from the File menu.

Creating A New Model

The first step in creating a model is to open a new set of model files. To open a new model...
® From the File menu, select the New item. The Save screen will be displayed.

® In the File name data field, enter a name for the new model. For example, type MyDemo
in the data field.

® From the Save as type list, select GASWorkS 11 (*.gwz).

2
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® When an appropriate New Model Name has been entered and the type has been selected,
click the Save command button to proceed.

Note... GASWorkS 11.0 supports two types of model file formats - the traditional or legacy “hdr” file

format (GASWorkS 10.2 and older) - and the GASWorkS 11 “gwz” format. The legacy format
stores the model as a group of individual files. The new format stores the model as a single file.

The Graphic Data Interface (GDI) Window should be displayed.

Note...| GASWorkS 11 supports two types of graphic data interfaces: the classic or legacy “toolbar”

type interface, and the new GASWorkS 11 interface, which replaces the toolbars with the
Command Tree. To use the legacy interface, select the Use Classic GDI Format option from the
Environment data tab of the User Options & Settings screen.

* The instructions provided in this document presume that the “new” GDI format will be used.

Note - If the GDI Window is not automatically displayed, select the View/Edit item from the Graphics menu
to display the GDI Window.

If the GDI Window is not sized to fill the GASWorkS application screen, resize the GDI Window using the
Maximize GDI Window command located either in the GDI Command List or under the GDI Utilities branch
of the GDI Command Tree.

Note...\ | To assist in building a model using the drawing method, GASWorkS provides two “snap”

methods that cause a pipe end to be snapped to an existing node. The first snap mode is called
“auto-snap.” This is implemented by holding down the Shift key and left-clicking the mouse when
prompted for a node location.

» The second method is called Feature Snap; this method snaps to an existing feature (node)
found within a certain distance of an entered location. To use this method, click the Feature Snap
icon from the lower-left corner of the GDI Window until the icon’s background is darkened.
When this method is turned “on,” a circle or target will be displayed around the mouse crosshairs
when prompted for a location. This circle represents the snap distance. When a feature, for
example, a node, is located within the target and the left mouse button is clicked, the location of
the targeted feature will be used as the selection location.

For this example, ensure that the Feature Snap is turned “on.” Click on the Feature Snap icon : |
located in the lower-left corner of the GDI Window until the icon’s background is darkened. The =3
Feature Snap will automatically force (snap) the new coordinate selection to an existing feature

within the Snap Target of the selected location.

=
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Setting The Default Data Values

When creating a new model or adding new features to an existing one, the data values for the new features
are set to the current default data values. If similar models are being created, these values only need to be
set once. However, if models that are not similar are being created, the values must be appropriately set when
changing model types.

An alternative to using the default data to populate values for newly entered features is to use the data from
the last similar feature in the model to populate the values for a new feature. To use this method, select the
Use Last Record As Default option on the Default Data tab on the User Options & Settings screen.

Note... . . .
In this document, two values are listed where a data value is given. The first value represents the

value in US (Imperial) dimensional units. The second value (enclosed in brackets [ ]) represents
the value in UK (Metric) dimensional units. Use the appropriate values.

To set the default data values...

® From the Utilities menu, select the Options & Settings item. The User Options & Settings screen
will be displayed.

® On the Units data tab, set the following values:

Coordinate Values = Feet [Metres]
Customer Loads = Mcth [M3h]

Diameter Values = Inches [Millimetre]
Efficiency Values = Decimal

Elevation Values = Feet [Metres]

Heating Value (Energy Content) Values = Btu/cf [MJoules/m3]
Length Values = Feet [Metres]

Node Load Values = Mcth [M3h]

Pipe Flow Values = Mcfh [M3h]

Pressure Values = Psi [mBar]

Prompted Length Values = Feet [Metres]
Temperature Values = Fahrenheit [Celsius]
Velocity Values = Feet/sec [Metres/sec]
Viscosity Values = Lbm/Ft-sec [Centipoise]

® On the Default Data tab, set the following values:

Use Last Record As Default = Unselected
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Customer Load = 0 Mcfh [0 M3h]

Node Base Load = -10 Mcfh [-280 M3h]

Node Base Load Known = Yes

Node Elevation = 0 Feet [0 Metres]

Node Pressure = 0 Psi [0 mBar]

Node Pressure Known = No

Node (Gas) Temperature = 60 Fahrenheit [15.6 Celsius]
Node Temperature Known = Yes

Pipe Flow Equation = IGT-Improved

Pipe Hydraulic Efficiency = 0.95 Decimal

Pipe Size/Type (Inside Diameter) = 2P Inches [63P-11 Millimetre]
Allow Pipe Sizing = No

Miscellaneous Data Values...
Pipe Facility Type = UnSpecified
Node Increment = 5
Pipe Sizing Group = Any

® On the Gas Properties data tab, set the following values:

Base Pressure = 14.73 Psi [1013.25 Millibar]
Base Temperature = 60 Fahrenheit [15.6 Celsius]

Specific Gravity = 0.6

Viscosity = 0.000007 Lbm/Ft-sec [0.0104 Centipoise]
Heating Value = 1000 Btu/cf [37.2 MJoules/m3]
Specific Heat Ratio = 1.3

Values Are Unknown = Unselected

® On the Graphics data tab, set the following values:

Flow Arrow Size = 3 % Of Display Width

® On the Reports data tab, set the following values:

Negative Pressure Nodes = Selected

® On the Environment data tab, set the following values:

B3PELLC

Allow Undo Of Data/Graphic Changes = Selected
Always Maximize GDI Window = Selected
Automatically Open GDI Window = Selected
Automatically Save At Timed Increments = Selected

Engineering & Software Services
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Display Tooltips = Selected
Prompt For Data During New Feature Entry = Selected
Note - Select the remaining options as desired.

® The remaining values and settings should be appropriate. Click the Apply command button to
apply the settings. Then, click the Close command button to close the screen.

Using The Graphic Data Interface (GDI) Window

When using GASWorkS, much of your time will be spent working within the GDI Window, so let’s take
some time to describe its various features. Commonly used commands are listed in the Command Tree
located on the upper-left side of the GDI Window. The tree contains various commands grouped by
functionality. Select a branch to expand the group, then select the item associated with the desired command.

by selecting a command from the GDI Command Tree, by selecting an item from the GDI
Command List, or by typing the command name or abbreviation on the GDI Command Line. In
this example, we will use a variety of execution methods. If a GDI Command is accidentally
selected, it may be canceled by clicking the Cancel icon.

In the GDI Window, a GDI Command is executed either by clicking the appropriate GDI Icon, @ ‘

The GDI Command List icon is located below the GDI Command Tree on the left side of the GDI Window.
Select a command from the list to execute.

The GDI Command Line is located at the bottom of the GDI Window, below where the mouse coordinate
values are displayed. Type a command name or abbreviation in the command line and press the Enter key
to execute the command.

When a feature is selected or a new feature is added, the associated data will be displayed in the upper-right
side of the GDI Window in the Data Panel. If changes are made to the associated feature, click the Apply
Data Values command button to save and apply those changes.

The main portion of the GDI Window is comprised of the GDI Display. The GDI Display is the portion of
the screen where the model image (GDI Image) is displayed. The Scroll icon is located in the lower-left
corner of the GDI Window. The view can be moved right or left and up or down by clicking one of the arrow
symbols on the icon. The Zoom To Fit, Zoom In, Zoom Out, and Zoom Previous icons are located next to the
Scrollicon. There are various other methods for zooming and panning, including using the mouse wheel and
buttons.

When a GDI Command requires keyboard input, a prompt will appear just above the GDI Display.
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* GASWorksS provides several ways to enter a node’s location. These include:

Specifying an X-Y coordinate pair;
Specifying a relative distance and angle;
Drawing the segment with the mouse.

» We will use each of these methods when constructing the example model.

(T3]

Note - If your Windows environment is set to use a comma “,” as the decimal separator, use a
space to separate the coordinate values.

Building The Model

Add The First Pipe Using The Coordinate Method Of Entry

® Click the Add 2 Point Pipe item from the Construction branch of the GDI Command Tree.

® For the From Node Location, type 1000,1000 on the GDI Prompt Line and press the Enter key.

® The Node Data will be displayed in the Data Panel. In the Hydraulic Data Items section, set the
following values:

Name = SUPPLY

Pressure = 20 [2000]

Pressure Units = Psi [mBar]

Pressure Known = Yes

Note - The Base Load Known should automatically be set to “No.”

® The remaining values should be acceptable. Click the Apply Data Values command button located
at the bottom of the Data Panel to continue.

Note... By changing the name of the node to “SUPPLY” does not make the node a supply point; setting
the pressure as “Known” and the flow as “Unknown” causes this location to be a supply point.
Nodes can have most any name up to 40 alphanumeric characters.
Z
2| B3PE LLC Engineering & Software Services
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To Fit icon in the lower-left corner of the GDI Window to zoom the GDI Image to fit the GDI

To make the pipe we just entered easier to see, let’s zoom in on the GDI Display. Click the Zoom @
Display. A single horizontal pipe with a node on each end should be displayed.

Table Of Contents

The setting of the “Known” items indicates whether the associated value is known or unknown.
When a “Known” item is set to “No,” the value is unknown and will be calculated during the
Solution routine. At this node, we indicated that the pressure was known (set to “Yes”) and that
the base load was unknown (set to “No”). Generally, either the pressure value or the load value
must be “Known” at each node, but not both. At supply nodes, the pressure is usually set as
“Known” and the load as “Unknown.” At demand nodes, the pressure is usually set as
“Unknown,” and the load is set as “Known.” A negative load value indicates that gas is leaving
the system.

Depending on the Zoom Scale, a node symbol may appear at the new node’s location. Whether
a node symbol is displayed or not, a “stretch” line should be displayed from the entered node
location. We will zoom in later to make the view easier to see.

® For the To Node Location, type 1500,1000 [1150,1000] on the GDI Prompt Line and press the
Enter key.

® The data for the new node will be displayed in the Data Panel. The displayed values should be
acceptable. Either click the Continue command button or right-click the mouse to continue.

® The data for the new pipe will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:

Size/Type Code = 4P [125PE-S11]
Diameter Units = Inches [Millimetre]

® Click the Apply Data Values command button to continue.

The Size/Type Code list contains various predefined Size/Type Codes. Each code represents an
entry in the Pipe Property Table. GASWorkS uses Property Tables to store redundant data items,
such as Inside Diameter values. Property Tables are provided for each hydraulic feature type. For
example, pipes, fittings, regulators, valves, compressors, and well features. The User may add to
or revise the data contained in any of the Property Tables.

B3PE LLC Engineering & Software Services
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Add The Second Pipe Using The Relative Distance & Angle Method

® Click the Add 2 Point Pipe item from the Construction branch of the GDI Command Tree.

Note...

Note...

Note...

To Fit icon in the lower-left corner of the GDI Window to zoom the GDI Image to fit the GDI

To make the pipes we just entered easier to see, let’s zoom in on the GDI Display. Click the Zoom @
Display.

® For the From Node Location, right-click the mouse to accept the default From Node coordinates
(1500,1000 [1150,1000]).

GASWorkS remembers the coordinates of the last node that was entered. When a default
coordinate pair is displayed, either press the Enter key or right-click the mouse to accept the
coordinates.

® For the To Node Location, type @500<180 [@150<180] on the GDI Prompt Line and press the
Enter key.

The “@” symbol tells GASWorkS that a relative distance and angle will be used to locate the
node. The node location is calculated relative to the From Node Location. Angles are measured
clockwise from the 12 o’clock position (top of display) - zero (0) represents north.

® The data for the new node will be displayed in the Data Panel. The displayed values should be
acceptable. Either click the Continue command button or right-click the mouse to continue.

Notice that the Node Data did not display for the From Node, but it did display for the To Node.
That is because the data is only displayed when a new feature is entered. The From Node was
previously entered, so the data was not displayed.

® The data for the new pipe will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:

Size/Type Code = 2P [125PE-S11]

® Click the Apply Data Values command button to continue.

=
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Add The Third Pipe By Using The Drawing Entry Method

® Seclect the Add 2-Point Pipe item from the GDI Command List.

® For the From Node Location, move the mouse crosshairs so that Node 15 is within the selection
target. Left-click the mouse to indicate the node’s location.

ote If the Node Data is displayed in the Data Panel, it indicates that the node’s location was not

properly selected. To reselect the From Node Location, click the Cancel icon and re-execute the
Add 2-Point Pipe command.

® For the To Node Location, move the mouse crosshairs to a location below Node SUPPLY and to
the left of Node 15 (similar to Node 20 in Figure 1). Left-click the mouse to indicate the node’s
location.

® The data for the new node will be displayed in the Data Panel. The displayed values should be
acceptable. Either click the Continue command button or right-click the mouse to continue.

® The data for the new pipe will be displayed in the Data Panel. The displayed values should be
acceptable. Either click the Continue command button or right-click the mouse to continue.

After entering this pipe, the model should look similar to Figure 1.

‘SUPPLY 4P, '10

‘20\
20
\'15

Figure 1
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Add The Fourth (Last) Pipe

® Double right-click the mouse while the mouse pointer is in the GDI Display to re-execute the last GDI
Command (Add 2-Point Pipe command).

® For the From Node Location, right-click the mouse to accept the default coordinates.

® For the To Node Location, type the letter N, a space, then followed by the node’s name SUPPLY
(N SUPPLY). Right-click the mouse, and press the Enter key to select the indicated node’s location.

ote By including the “N” prefix, you are indicating that a node name will follow and to use that

node’s location for the To Node Location.

® The data for the new pipe will be displayed in the Data Panel. The displayed values should be
acceptable. Either click the Continue command button or right-click the mouse to continue.

After entering the last pipe, the model should look similar to Figure 2.

SUPPLY. P, ‘10

Figure 2
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Solve The Model

Now that the model has been created, the unknown pressure and flow values may be calculated by “solving”
the model. To solve the model...

Note...

® Click the Solve icon from the lower-right corner of the GDI Window. The Solution
Data screen will be displayed. %

® For this example, the default Solution parameters should be acceptable. Click the So/ve
command button to proceed with the Solution.

® While the Solution is performed, the Solution Log will be displayed. The Solution Log displays
the Solution activity and informs the User when the Solution is complete.

Solutien Log...

Model: C:\Program Files (x86NGASWorkS 11 - Training\temp\Demo'4354735\gwz. ..
Preparing Data For Solution...

Performing First teration

lteration 1: Max Error = 16.445 Mcfh - 3 Nodes Unbalanced
lteration 2: Max Error = 7.901 Mcfh - 3 Nodes Unbalanced
fteration 3: Max Error = 3.765 Mcfh - 3 Nodes Unbalanced
lteration 4: Max Error = 1.831 Mcfh - 3 Nodes Unbalanced
tteration 5: Max Error = 0.903 Mcfh - 3 Nodes Unbalanced
lteration &: Max Error = 0.448 Mcfh - 2 Nodes Unbalanced
lteration 7: Max Error = 0.224 Mcfh - 1 Nodes Unbalanced
lteration 8: Max Error = 0.112 Mcfh - 1 Nodes Unbalanced
lteration 9: Max Error = 0.000 Mcfh

Average fteration Time = 0.00 Seconds

Saving Results...

Solution Complete.

Close

* The Solution Log displays the progress of the Solution routine. In a normal solution, the node
errors should start relatively large and decrease as the Solution progresses until the node errors
are less than the specified convergence tolerance. The last line of the Solution Log should
indicate “Solution Complete.” If the Solution is not complete, or exceptions are reported, recheck
the model creation steps, correct any errors you encounter, then re-solve the model.

* The values displayed in your Solution Log will most likely not be the same as the values listed
above. However, they should be close, and the last line should indicate “Solution Complete”. If
the log does not say that the solution is complete. Retrace and check the model-building steps,
then and try again.
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® Upon completion of the solution, click the Close command button to close the Solution Log and
return to the GDI Window.

When the solution is complete, the Solve icon symbol will change. The scale is now blue and
balanced, indicating that the model is balanced. glu""'ul_é

View The Analysis Results

Now, let’s review the analysis results. In addition to its various Report routines, GASWorkS provides several
graphical methods for viewing the model data and the analysis results. We will look at the Report routines
later; for now, let’s use some graphical methods to view the analysis results.

Notice that the flow arrows are now displayed, indicating the direction of the pipe flow.

Note... Ifthe flow arrows aren’t displayed, click the Display Flow Arrows item from the Display Settings

branch of the Command Tree. Realize that sometimes the flow arrow symbols might be obscured
by the pipe size text.

Let’s display the pressure values for the nodes...

® Click the Text Display Settings item from the Display Settings branch of the GDI Command Tree.
The Text Display Settings screen will be displayed.

® On the Node Items data tab, set the following items:
Display Node Text Items = Selected
Transparent Font = Unselected

Node Pressure = Selected

® Click the Apply command button to apply the changes to the display.
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The pressure values and flow directions should be similar to those shown in Figure 3.

SUPPLY P, '10
P =20.00 Psi = P =19.68* Psi

Y

P
<

20
P = 17.93* Psi

\.15
P =17.85* Psi

Figure 3

Note... . . .
* The displayed pressure values represent the estimated pressure for each node point. As a result

of the “drawing” of the third and fourth pipe segments, each example model is created slightly
differently. The different pipe lengths will cause different pipe resistance, and the different pipe
resistance will cause different pressure drop and pressure values. A large difference indicates an
error has occurred during the model creation. If so, you might want to retrace the steps to identify
the problem.

* The analysis results for an individual pipe or node can be viewed and printed using the Edit
Node and Edit Pipe commands or by clicking the mouse on the desired feature.

» Sometimes, it is desired to move a text value to make it or another feature more visible or
readable. An easy way to move text is to:

* Click on the associated feature (node, pipe, customer). When selected, two boxes will
appear. These are known as grips.

* Click in the grip nearest the text value.
* Move the mouse and text outline to the desired location.

* Click the left mouse button.
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Tap A Pipe

To simulate a new connection to the system, let’s add a new node (a pipe tap) to the pipe segment between
Node 15 and Node 20. To make a tap...

® Click the Tap A Pipe item from the Edit Graphics branch of the GDI Command Tree.

® At the Select Pipe To Tap prompt, move the mouse pointer to the pipe between Node 15
and Node 20 and left-click the mouse. The selected pipe segment will be highlighted
“yellow.”

® For the Tap Location, move the mouse crosshairs midway along the pipe segment between
Node 15 and Node 20 and left-click the mouse. A node will be placed at the selected
location.

® The data for the new node will be displayed in the Data Panel. In the Hydraulic Data
Items section, set the following values:

Name = NEWTAP
Base Load = -40 [-2500]
Load Units = Mecfh [M3h]

® The remaining data values should be acceptable. Click the Apply Data Values command
button to continue.

Note...\ | The load for the Node NEWTAP was entered as a negative value. Remember that a negative

value indicates a load leaving the system (a demand).

* Because a change has been made to the model, the previously computed pressure and

flow values are no longer valid. To see the effect of the new load on the system, we %
will need to re-solve the model. Notice that the So/ve icon has changed - the scale is

now unbalanced, indicating that the model needs to be solved.

Window. A message will appear warning of possible exceptions. Click the Yes command button
to view the exceptions listed in the Solution Log. Note the locations of the listed features, or
double-click on an exception row to flag and zoom to that location in the GDI. To redisplay the
Solution Log, click on the Solution Log Report item in the Window menu list.

Re-solve the model by clicking the Quick Solve icon in the lower-right corner of the GDI =
. ‘

=
,3 B3PE LLC Engineering & Software Services
Revision - 001, Copyright 2025, All Rights Reserved.




GASWorkS™"11.0 Demonstration Guide

Table Of Contents

In Figure 4, the pressure values are negative (less than zero) at the noted locations. This indicates that the
system has “run out of gas.” In other words, the increased demand caused by the new load is greater than the
system’s capacity.

SUPPLY.
P =20.00 Psi

Y

‘10
P =18.87* Psi

)

20
P = 2.23* Psi

SN

\‘NEWTAP
P = -14.73* Psi

N
\.1 ;
P = -2.44* Psi

Figure 4

To correct this issue, normally, you might increase the size of the pipes with the highest pressure drop. Let’s
use the color-coding features to identify the pipe or pipes with the highest pressure drop, and increase their
size.

Color Coding Pipes & Nodes

GASWorkS provides several routines for color-coding pipes and nodes based on their data values. Features
may be colored based on the results of a query. For example, pipes with pressures value below a specific
pressure value could be colored red. Features may also be colored based on a range of values. The range
values and colors may be set by the User or automatically set by GASWorkS. Let’s use one of the automatic
range methods to color-code the pipes.

To determine which pipes have the highest pressure drop, we will color-code them based on their pressure
drop values.

® Click the Color Display Settings item from the Display Settings branch of the GDI Command
Tree. The Color Display Settings screen will be displayed.

=
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® On the Range Colors data tab, set the following values:

Item = Pipe Pressure Drop
Units = Psi [mBar]

® Click the Calculate command button to automatically set the range values. Values will

be displayed in the From and To data fields.

® Click the Apply Range Colors command button. The colors of the displayed pipes will be
updated to reflect the range color values similar to those shown in Figure 5.

Note...

color swatch to select a new color.

If the color settings are not to your liking, the User can select new color values by clicking in a

SUPPLY.

\g

P =20.00 Psi

20
P = 2.23* Psi

e

\‘NEWTAP
P = -14.73* Psi

3
G

15

P = -2.44* Psi

‘10
P =18.87* Psi

Figure 5

As a reminder of the range color values, the Color Legend will be
displayed below the GDI Command List on the lower-left side of the
GDI Window. The Color Legend will be displayed using the calculated
color and value ranges.

=
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Below 3.653
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Note... . . . .
%% In this case, the pipes with the highest pressure drop are colored “black.” The segments between

Node 10 and Node 15 and between Node SUPPLY and Node 20 might be colored “black,” or one
or the other might only be colored “black.” The results vary because of the varied pipe lengths
resulting from the drawn pipe segments.

Let’s try to fix the pressure problem at Node NEWTAP by changing the size of the pipe between Node
SUPPLY and Node 20.

Edit Pipe Data

During some previous steps, we used the GDI edit features to change the data associated with the new nodes
and pipes we entered. Now, let’s use the GDI’s edit features to edit the size of the pipe between Node
SUPPLY and Node 20.

® Sclect the pipe segment between Node SUPPLY and Node 20 by moving the mouse pointer near
the pipe segment and left-clicking the mouse.

® The data for the selected pipe will be displayed in the Data Panel. In the Hydraulic Data
Items section, set the following values:

Size/Type Code = 4P [125PE-S11]
Diameter Units = Inches [Millimetre]

® Click the Apply Data Values command button to save the changes.

® Click the Solve icon in the lower-right corner of the GDI Window. The Solution Data
screen will be displayed. %

® On the Solution Data tab, set the following values:
Update Color Coding = Selected
® Click the Solve command button. The Solution Log will be displayed. Review the results, then

click the Close command button to close the log.

We can see that all of the node pressures are now positive. If the current values are adequate, we can
conclude that the change fixed the problem; otherwise, we can change additional pipe sizes and re-solve the
model to see the results.

=
,3 B3PE LLC Engineering & Software Services
Revision - 001, Copyright 2025, All Rights Reserved. 71




GASWorkS™"11.0

Demonstration Guide

Table Of Contents

Note...

Notice that the pipe colors were updated to reflect the new pressure drop values. By selecting the

Update Color Coding option, the last range color values were used to update the GDI feature
colors after the solution was complete.

We can reset the feature colors (pipe colors) to their original color values. To do this, on the GDI Command
Line, type RESET and press the Enter key. The feature colors (pipe colors) will now be displayed in the

original default colors.

Working With The Data Reports

To view the Node Data Report...

® From the Report menu, select the Node Data item. The Node Data Report will be displayed.

=] Node Data Report...

= = A =z b v ™
HEE =53 4E] Q)= Z] £k

Model Data

Record No Name Internal I Pressure Pressure Units Pressure Known Base Load External Load f’?;eerg;l Eoe
! SUPPLY 2 20.00 Psi es TO.0M3 0.000 0.000
2 10 4 19.28 Psi No -10.000 0.000 0.000
3 15 (] 10.60 Psi No -10.000 0.000 0.000
4 20 3 19.12 Psi No -10.000 0.000 0.000
5 NEWTAP 10 9.38 Psi No -40.000 0.000 0.000

Close
Sort the results in the Node Data Report from the lowest to the highest pressure value. To do this...

® Click the Make Selection Set icon. The Query Specifications screen will be displayed.  |Eg
Set the following values: =J1

Where = Node Pressure

Is = Min
To=10

® Click the Perform Query command button to create the selection set. A message will be displayed

=
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stating the number of matches found. Click the OK command button to clear the message.

® Click the Close command button on the Query Specifications screen. The pressure node values
should now be listed from lowest to highest.

Record No Name Internal IO Pressure Pressure Units. Pressure Known  Base Load
5 NEWTAP 10 9.38 Psi No -40.000
3 15 6 10.50 Psi No -10.000
4 20 8 19.12 Psi No -10.000
2 10 4 19.28 Psi No -10.000
1 SUPPLY 2 20.00 Psi es 70.013

Note... . . .
* The contents of the reports can be manipulated by creating “selection sets” based on User-

specified selection criteria. The previous few steps created a sorted selection set, which found the
ten (10) lowest pressure node values. In this case, only five nodes were in the model, so all
records were included in the selection set, ranked from lowest to highest. Successive
selection sets can be created.

* A selection set can be “cleared” by choosing the Reset Selection Set icon.

® Click the Close command button to close the Node Data Report.

From the Report menu, select the Pipe Data item. The Pipe Data Report will be displayed. Use the horizontal
scroll bar to view items displayed on the right side of the report. As you scroll, you will see the various items
reported for the pipe features, including the calculated Velocity, Volume, Flow Rate, and Pressure Drop
values for each segment. When you are done browsing the report, click the Close command button.

Note... . . . .
* This example barely touched on the many features associated with the various reports. The

reports allow data editing directly from the report screen by simply clicking on the appropriate
data cell. The User may control the report’s contents by expanding and collapsing columns and
creating query-based selection sets. Several routines are also provided for sorting and browsing
through the report contents.

* To better fit the report on the printed page, try reducing the number of columns by using the Set
Columns routine to specify which columns to display and print. When the Set Columns icon is
clicked, the Column Settings screen will be displayed. The selected column names represent the
columns that are currently displayed. Unselect some of the columns.

* The reports can be saved to the Windows Clipboard and pasted into another application, or
saved as a Comma Separated Values (.csv) file and opened in a spreadsheet application.
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What To Do Next

These last few steps demonstrate the most powerful use of GASWorkS: the ability to study the effects of
system modifications before they are implemented. By analyzing these effects using the model, changes that
might adversely affect the system may be identified before they become a real problem. Furthermore,
solutions to counter or fix the results of a negative change can be easily tested in the model, avoiding
installing incorrectly sized facilities in the field.

There are several pre-built example models distributed with the software. Refer to the Help Guide in the Help
menu for descriptions and instructions for viewing the various example models. These pre-built examples
include applications that use regulators, hydraulic valves, fittings, compressors, and wells, and demonstrate
many of the software’s features. Other examples can be found in the Training Examples section of our
website (www.b3pellc.com).

Instructions for using the many commands are included in the Help Guide.

This simple example provided a brief overview of the basic routines found in the GASWorkS software. Many
routines were not used in the example: the Import and Export routines, attribute valves, tracing, data
checking, the use of the Pipe Sizing routine, the use of the customer data features, the use of a background
image, and the use of the GeoMapping features were all absent from the demonstration example. Perhaps
you may wish to explore some of these features on your own. These features are found in the User’s Manual
or the Help Guide. These documents may be downloaded from the Support section of our website.

When you are done exploring the software, select the Exit GASWorksS item from the File menu to close the
program. A message may be displayed asking whether to save or discard the changes made to the model -
select the appropriate option. If you choose not to save the changes, they will be ignored.
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Uninstalling GASWorkS

If, after using the GASWorkS demonstration software, you wish to remove it, select the Uninstall GASWorkS
11 Demo item from the GASWorkS Programs folder.

® After the Uninstall Program has been started, read the contents of each screen carefully and respond
appropriately.

Note...

If the Uninstall Program asks to remove any shared system files, click the No command button.

® A message will be displayed when the Uninstall routine is complete. The message will indicate whether
the routine was successful or whether it failed. Select the appropriate option to clear the message.

Note...

® On some devices, the Uninstall routine will not be able to remove any directory or file that has
been created after the initial installation.

® Some of the files and/or folders created by GASWorkS after the installation may include files
in the initialization directory (ini), files in the default model file directory (files), and/or files in
the application directory (app).

® To remove these files and/or folders, use Windows File Explorer to find and delete the
remaining files and folders. An example of the path for the initialization folder is shown below.
The other folders have similar path locations.

* 32-bit machines - C:\Program Files\GASWorkS 11 Demo\ini
* 64-bit machines - C:\Program Files (x86)\GASWorkS 11 Demo\ini
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